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L.8 USING INTERNET
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Guess how we can get the latest news, watch cricket, chat with , |

buddy, and check the availability of railway reservations and flight
) reservations?

T T P

It is possible with the Internet. |

T e

Using the Internet, everything
happens by magic with only a few
mouse clicks. Millions of people
across the globe can communicate
and interact with each other
through the Internet.

B N N O

PN NSNS

Read Jump Start at the beginning of the chapter.

Page No. 106

/ﬁ o o Type the keyword ‘modes of transport’ in
?’:’N AcM" the address bar of the browser. Press the
: Enter key to view the different types of
k information it displays.

To be done practically in the computer lab.
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. ASSESSMENT
“ TIME

Section-I

A Fill in the blanks. Conceptual Understandis

1. The Internet  allows us to do online shopping, play online
games, and watch online movies.

2. Every Website has an address.

3. A _Web page is a part of a website.

4. A Web Browser is a computer application used to view websites.

Page No. 108

| B' Multiple Choice Questions.

1. WWW stands for
(a) World Wide Web Q\Z{ (b) Wide World Web
(c) Web World Wide {3 (d) World Web wide
2. Which of the following is a web browser?
(a) Internet Explorer {::3 (b) Apple Safari
(c) Google £73 (d) All of these
3. Internet is a )
(a) A single network {:} (b) Network of computers ‘=

(c) Website {::3 (d) None of these

4. A is used to segrch for the information.
(a) Search engine (b) Browser
(c) WWW {:} (d) None of these

108
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C.
1.

AnSs.

AnSs.

Ans.

AnSs.

Answer the following.

What is Internet?

The Internet is a network of computers that is used to share the information
across the world.

Which application software is used to view websites?
Web browser is a computer application used to view websites.

Write any two uses of the Internet.
(i) It helps us share information.
(i) It allows us to do online shopping and play online games.

What is the use of Search Engine?
A search engine is a website that searches the information based on

the keywords entered by the user for example Google, Yahoo etc.

Page No. 109

D Match the following

e~ e

_,-»,hs

1. Internet l( g(a) 1S apage on a websie 9
2. Webpage ll  (b) is the network of computers
. ’ ;
| - actoss the world
‘ | ‘ iew different websites
3, WWW 0 g(c) lets you v ;

" (d) is the largest collection of
information on the internet 3.

4. Web Browser f
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AnSs.

Page No. 109

E Rearran L o
2 ge the followmg Jumbled letters to make meaningful words.

a. ORKNETW @ E (1) 0 (R
b. NETINTER ONG % R (N &

(T
c. ETISWEB WE)®E) 7 ®
d. WBROSER R)(0OW s &) ®
Page No. 109
| F Write the name of the following browsers:
a. b. C. .
| GOOGLE CHROME APPLE SAFARI INTERNET EXPLORER
Page No. 110
Section 11
Application Based Questions
Section-ll
o"lmi .
N Application Based Questions Experimental L

Gungun is asked to create a chart on the various input devices of a compute:

She wa.nts to paste pictures on the chart. But she does not know how to searc
on the internet. Would you help her in her project?

She can use the Search Engine like Google to search for the information.
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CBE Based Questions

~A. Fillin the blanks.
= 1. People across the globe can communicate with each other through the |nternet .
AWeb Page is a part of a Website.

ASearch Englnse

2
3. 15 a website that searches for information based on keywords.
4

Navigating between Web pages is also called _Browsing/Surfing

B.  Write “True” or “False”.

The word internet stands for interconnected network.
The internet was invented in 1989.

A collection of related web pages makes WWW.
URL is a type of Web Browser.

o bed O e

mc. Multiple Choice Questions.
I Whﬁic?yf the following is used to view websites?

Web Browser (b) WWW
(c) Search Engine (d) None of the above
2. Which of the following is an example of a search engine?
(a) Google (b) Yahoo
V Both (a) and (b) (d) None
3. Which of the following provides a list of options?
M’lenu (b) Search Engine
(c) Web Browser (d) None of the above
4. Which of the following is used to navigate between web pages?
(a) Menu (b) Links
Both (a) and (b) (d) None
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Name the important components of a Website.

| Webpage |

Web Address/ ]

Home

The School

Academics

Campus

Media Gallery

Admission

Parent Corner

(BSE Section

Contact Us

Srcomie AGWsHOE o
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Delhi Public School, Gandhinagar
Class- 11
AlL: Practical
L..8 Using Internet

| webpage |

Web Address/

]

Home

The School

Academics

Campus

Media Gallery

Admission

Parent Corner

CBSE Section

Contact Us

[} = 80
S UCsmoee AW zos . B
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Keywords
|

¢ o (0 %% googlecom/search?q=how+to+make+Pmonadedisca esv=ald1dctf882aaB 3 &susrf=ADLYWIIDgTGAWfS8dnpi6YbsPLOwio59qQ%3A1731940625708Rei:

GO g|e how to make lemonade X

—(-—
)
Jo!

Al Videos Images Shopping News Web Books i More Tools

Stepbystep  Forkids ~ With1lemon = Withoutsugar ~~ Withlemonjuice  Inablender =~ With 2lemons

% Sugar Spun Run
@ https:/sugarspunrun.com; Drinks &

Homemade Lemonade Recipe

8 Jun 2022 — Instructions. Combine 1 cup (236mI) water and 1 cup sugar in a small
saucepan. Place over medium-low heat and stir until sugar is dissolved.

50 (202) - 15 mins

People also ask

What are the 7 steps of making lemonade? v
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Delhi Public School, Gandhinagar
Class- 111
Computer Sample Notebook
L.4 More About Word (November’24)

g'* Jump Start |

Fill in the blanks by choosing the correct word.

B
1. Word Processing is a program that allows you to Ribbon
create documents like letters, and reports.

2. One of the options that you have in the file tab [ Save j

s Save

3. The Ribbon contains all of the Close button }
commands you will need to perform common |

tasks in MS Word.
4. The Cleose button exits the word window.

<'
(
ENord Processinal 5 |
{

= f;«’* ) Acﬂvitr‘ Create a new document in MS Word and
w type two paragraphs.

1. The first paragraph should contain information such as the name
of your school and where it is located. You can write about your

. teachers and classes in the second paragraph.

2. Save the document with the file name ‘My School'.

\

To bedonepractically in thelab.
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[““ Activity2 ©

pen MS Word and perform the following ‘l

tasks. |

Task 1. Open the file 'My School that you created in Activity 1.

Task 2. Cut the last two lines of the document.
Task 3. Add your Name, Roll No. and Grade and save the document.

Tobedonepractically in thelab.

/ Activity

3 Type the following poem in MS Word and
apply the formatting as shown in the image.

A tiny, spiny dinosour
was racing through my house.
a tiny, spiny dinosour no bigger than a mouse.
That tiny, spiny dinosour,
it leapt up on my bed.
It chased me from my bedroom and pursued me down
and it hit me on the head.
It chased me from my bedroom
ursu n i

It knocked the TV over

\ .

Tobedonepractically in thelab.

\
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ASSESSMENT |

Sectiond
A Fill in the blanks.

Conceptual Understanding

1. Bold button 1s present in the group of the Home tab.

. Capitalize each wo ) each
2. On selecting P case, the first character in i word

of the selected sentence will be converted to the Capital Letter.

3. The cut command is used to move the original text from
one place to another place.

4. The Sentence case makes the first letter of each sentence capital.

Page No. 58

| B Write (T) for true or (F) for false statements.

I. It is not possible to change the size of the text in Word. F

2. You cannot apply italic and underlined effects if a text
1s already bold.

F
3. The Font box holds almost all the text formatting options. T
4. You cannot change the colour of the text. =
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C  Multiple Choice Questions.
Which option is used to type the text in the following format’

1. Asha
(a) Bold (% (b) Underline 3
(c) Italic :* (d) Bold and Underline \!
2. Happy ~
(a) Italic \/ (b) Bold q
(c) Italic and Bold {3 (d) Bold and Underline (_
3. ,GE_”L{S oo o~
(a) Bold ‘. (b) Underline .
(c) Italic \:3 (d) Italic and Underline ‘y
4. cursor .
(a) Italic () (b Bod \31
(c) Italic and Underline () (d) None of these (9

Page No. 58

D. Answer thefollowing.

Explain the use of the following (1, 2, 3) commandsin MS Word. (to be donein Text book)
Ans. Bold - It makesthetext thicker.

Italic — It dantsthetext to theright.
Underline— It placesalineunder thetext.

2. What do you understand by formatting text?
Ans. Formatting a text means changing the appearance of text in the document.

3. Whatisafont?
Ans. Font isa collection of charactersin a specific style or design.

4.  Write the shortcut keys of Cut, Copy and Paste Commands in word.
Ans.  Command Shortcut Key
Cut Ctrl + X

Copy Ctrl+C
Paste Ctrl+V

Page 4 of 10




5.  Answer thefollowing questionsin complete sentence using the type of “Change Case” given in
the bracket. (Extra Question to be donein Notebook)

5. Doasdirected (Changethe Case of the given sentence as given in the bracket.) (Extra
Question to be done in Notebook)

1. What isyour name? (Sentence Case)
Ans
2. Which house you belong to? (L ower Case)
Ans
3. 1likeToPLay CRICket. (repeat the sentence using Toggle Case)
Ans
4.  Which sport toyou liketo play the most? (Upper Case)
Ans

5. | lovemy family. (Capitalize Each Word Case)

Ans
Page No. 59
Section-li
T J = ~
v'¢i". | ppplication Based Questions  Experimental Lesming
L 3 e r
g aragraph on “My Hobbies™ 1n Word.

and size in the
k. Can you help

. Manpreet has typed & p ‘
| She I:’vams to change the case, font, font colour

' tas
document. But she is unable t0 complete her

. 0
her in completing her task’

Ans. She can usethe Change Case, Font, Font Color and Font Size of the Font group.
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g

Fill in the blanks. Formatting tools
I. M5 Word provides vanious to change the color and appearance ol
the text '

L

The Italic option allows vou to mahcize the text of your document.
1. A&t 4 collection of characters in a specific style or design,
4. The Sentence case makes the first letter of each sentence capital.

Write “True” or “False”.

1. To change the text, first you need to select the text.

/-

2. You can also use the Shift + arrow keys on the keyboard to select the text.

3. Once typed, you cannot change the size of the text in your document.

4. You can also apply more than one format tools to the selected text.

QWG

Multiple Choice Questions.

L. ‘u‘uynf the following key shortcut is used to select the entire text?
Ctrl+A (b) Shift+W '
(c) Cul+D (d) None

2. Which of the following is not a formatting tool?
(a) Bold (b) ltalic

\c/bndu _ (d) Underline

3. Which of the following options contains the tools to change the appearance of
the text? |

WHI (b) Clipboard '

(c) Styles (d) Editing ‘

4. Whicp of the following allows to switch between two cases? ‘

Caps Lock (b) Toggle
(¢) Sentance (d) None

| —
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A ldentify the Change Case applied to the Sentence and Name accordingly.
“I love the people of India.”

1 I lovethe peopleof India.
Ans Sentence Case

2 ilovethepeopleof India.
Ans Lower Case

3 | LOVE THE PEOPLE OF INDIA.
Ans Upper Case

4 | Love The People Of India.
Ans Capitalize Each Word case.

5.  “i LOVE THE PEOPLE OF iNDIA.”
Ans Toggle Case

Delhi Public School, Gandhinagar

Class- |11

AlL: Practical
L.4 More About Word 2016 (November)

Note: Follow the detailed steps given in the textbook L -4.

Editinga Text
I. Selecting a Text

W-o@r Docvmment? - Mcroselt and
[ aea g Lypot fefnienen Maiwrge Feve= Vdw Orvrzoa

S

. AR ’ =+ 4=« 3. i | v 1 fine
Comdean 3 A A Mar W B ECE RS Lacax) e AaBbC Aatvee AQD A 3
BJ U w %A EEAW - 2 v | thome T T NO Sp Wasegl  raeng ) Tne

A

rets
Clodewy foet LT . Wyt 1oting

(91 s it SO S b 00N MORCIY SEI BRI ENONN | i | SURATSS ROSCUESE SCRORCS SONUSEN | MNOHEN | om0 | [V RO NN ST MOA S A RO S )

s

On the Insert tab, the galleries indude items that are designed to coordinate with the overall look of
your document, You can use these galleries to insert tables, heades; footers, lists, cover pages, and
other document bullding blocks. When you create pictures, charts, or diagrams, they also coordinate
with your current document look.

You can easily change the formatting of selected text in the document text by choosing a look for the
selected toxt from the Quick Styles gallery on the Home 1ab, You can also format text directly by
using the other controls on the Home tab. Most controls offer a choice of using the look from the
current theme or using a format that you specify directly,

ey =, :
Semam i _Pagelafl | WO 18 3D AR KL Ttk Cheopec O TFIQ-2.m 280N (- . ..
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2.

Cut, Copy, Paste

Formatting Text

Changing the Style of the Text

Font Size
Calibri (Body) ~111 ~IA” A" | Aa~ | B
B I l_J_ v ab X, x‘z A v £ % ~

Color

Changing the color of the text

B H S O -
FILE HOME |MSERT DESIGM PAGE LAYOUT REFEREMCES MAILINGS REVIEW
iy X [ " - — 1— 1— g
caidh Calibri (Body) ~ |11 ~| A" A" Aa- A =-i1E-%. &= 4
Pl o by "
2 - 2 - - - = = = - -
- ¥ Farmat Painter I Byaex, X A A B — — — | 4= ‘—{_2 o
Clipboard = Font Ml Automatic
L Z 1 1 | Theme Colors 5.

Standard Cofors
HE fEEEEN
%¥ More Colors...

[ Gradient b
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iii.  Changing the Font style of the text
E] E & (_lj -

FILE HOME IMNSERT DESIGM PAGE LAYOUT REFEREMCES MAILINGS REVIEW
aills

. Gl BV -|A A A B ECE-E- &=
BB Cow | |
Paste Theme Fonts | A — o
- ¥ Format Painter TR . I === = 3_2 o
Calibri Light {Headings)
Clipboard ] | Paragraph
= Calibri Body) — = -
Mangal (Headings)
Mangal {Body)
2]

Recently Used Fonts

- O Arial

(F Calibri

() Times New Roman
4 (F Foterman

( ALGERIAN

(} Arial Black
(' Comic Sans MS

{} Mangal EFATHET

b Al Fonts
iv.  Changing the Font size of the text

@ HS O: =
HOME  INSERY  DESIGN  PAGELAYOUT  REFERENCES  MAILINGS  REVIEW

o . = o B ]

Y i Calbi(Body) |1 B A A A3~ % = -i=.%-. gmeE 2
Pa.::c ¥ Format Painter .- .b: R Z- A EBEE = 2
Clipboad - 10 Ta Paragraph
. 11 2 1 1 2 3 3 5
0
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i. Changing the Case of the text

BE S O-
FILE HOME IMSERT DESIGM PAGE LAYOUT REFEREMCES MAILIMNGS REVIEW
s Wyt e I B lis iy || 8
D_ |Calibri (Body} ~|1T ~-|A A Adx @ 1= ~:i=~- 2=~ & 3= 7,
ER Con L |
Paste ' 5 z i Sentence case, = = 2ot
- ¥ Format Painter B X M vaheX X A S é\? :
lowercase
Clipboard ] Font aragraph
i
= 3 7 UPPERCASE T =
LCapitalize Each Word
tOGGLE cASE
[ -]
P
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Delhi Public School, Gandhinagar

Class- |11
Computer Sample Notebook
L.3 Working with MSWord (October’24)

Page No. 29

' Can you guess who am |7

| allow you to write letters. _Keyboard

| allow you to move to the next line. _Enter Key

| | allow you to delete the letter to the left of the cursor.  Backspace Key

) | allow you to move the cursor up, down, left and right. _Arrow Keys

' | allow you to delete the letter to the right of the cursor. _ Delete Key

& | allow you to create blank space between two words. ~ _ Spacebar Key

Page No. 34

—

Lo/ ACtIVIRY 1 perform the following tasks in MS Word.

Task 1: Open a new document.

' Task 2: Type the following nursery rhyme.
One, two, three, Four and five,
| caught a hare alive; Six, seven, Eight,
Nine and ten,
| let him go again

Tobedonein Practical

Page1of11




Page No. 40

* ASSESSMENT
TIME
Section-l

A Fillin the blanks.

ﬁ

1. The Caps Lock key is a toggle key. 1

2 The l.JﬂdO command is used to remove the last action
done in the document.

3. The Minimize button is used to reduce the size of the MS
Word window

4. The Save command is used to save the document

Page No. 40 and 41

B - Multiple Choice Questions.

«1. The words and sentences that we type on a computer are called

(a) Letters (b) Number %
(c) Alphabet (d) Text ?‘:

2. The key is used to start typing on a new line ina

word document. |
(a) Enter (b) Spacebar E
(c) Shift (d) Al =

shortcut key is used to undo the changes in a

(3° The
document.
@ crl+x ) ® cul+Y (3
(©) Cirl+2Z @ (d) Ctrl+C )
4. is used to reverse the previous action.

i (@) Close O (b) Undo 4
(c) Back {:} (d) Redo O

Page 2 of 11
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C Write (T) for true or (F) for false statements.

1. Microsoft Word is a Word processor. = T -_

2. The cursor is a small blinking line. ! |

3. You cannot open a saved document. .» F

4. The backspace option is used to delete a letter. T
Page No. 41

D. Answer thefollowing.

1. Which key isused to type the text in capital |etters?
Ans. CapsLock Key.

2. What are the various options to erase your text in adocument?
Ans. The Delete Key and Backspace Key are used to erase the text in the document.

3.  What isthe difference between Undo and Redo command?
Ans. Theundo command isused to removethelast action donein the document,
wher eas, Redo command helpsto rever se an undo command.

4. Write the shortcut keys of the Undo and Redo Commands.
Ans. Undo Command - Ctrl +Z
Redo Command - Ctrl +Y

Page 3 of 11




Page No. 41
Section-li

%438 Application Based Questions

1. Radha is learning to work in MS Word. Help her to identify t
options she will use in the following situations.

(a) She typed some text in her document. It got deleted
mistake. Which option will she use to recover the text?
Undo Command

Page No. 42

(b} She is typing some text in her document. She wants to moy ¢

{o the next line in the document. Which option will she usc
for the same?
Enter Key

(c) She has finished typing in h
g 1n her document. Which opti '
she use before closing the doc wpon il

ument?
Save Document

Page 4 of 11




CBE Based Questions

Fill in the blanks. !
1. Microsoft Word is a very popular _Word processor :

2. The Maximize button is used to increase the size of the MS Word window.

3. When you open MS Word, a document  is created automatically.

4. You can type letters in capital case using the Capslock ey

|

Write “True™ or “False™.

1. You cannot make changes after saving the document

2. The Undo button is present in the View tab.

3. The Backspace key 15 used to position the cursor n o Word document
4

A cursor tells the typing posibon 0 a document.

C.  Multiple Choice Questions.
1. Which of the following is a toggle key to switch on and switch ofl the numernic

keypad?
(a) Caps Lock {b) Num Lock
(c) Alt JBoth (a) and (b)

2. Which of the following s a shortcut key for the Redo command?
(@) Ctrl+A & Cutey

(¢) Cirl+Z {d) Curl+V

3. Which of the following contains the Save command?
(a) New ) File
(c) Home (d) View

4. Which of the following can be done using a word processor?
(a) Type documents (b) Jdit documents
(¢) Formal documents J All of the above

Page 5 of 11




Delhi Public School, Gandhinagar

Class- 11

AlL: Practical
L.3 Working with Word 2016

Note: Follow the detailed steps given in the textbook L -3.

Opening MSWord
I. Click on start.
ii.  Click on search box and type word.

iii. Click on Word 2016.

D AR TN AT G AR AN

£ i e DA TN o - meyed o

B0 A8 PA X2 WS D0 el o
VO WL P RS0 3 VR VLD el G

By AR T Sy £ e

O NI LITE PN AT

8 Joepw matow (M8 vihiaes

[ RRTESTV T 0 F P PP

£ Metor gty e

|2 e e ¢ e @

- mv
] I 0 wod Cuwcow ~GTeSuwm JU. B,

iv. Select the blank document as shown below

o

Page 6 of 11




2 Creating a new document.
I.  Click on File menu.

li.  Select the New option.
lii.  Select the Blank Document option.

MS Word Window Components

S"ﬂ Access Toolbar | (M"""l;'ﬂ At

L Ribbon

u.-.L .... “ -
St;atusBar~

3. Typing Text and Numbers.
Stepsto type atext in a document
I Click on theblank area. A cursor appears.
ii.  Typeany letter using the keyboard.
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4. Typing Lettersin Uppercase

5.

Stepsto type lettersin upper case.
To type in uppercase, turn on the Capslock key and type the letters.
To typein lowercase, turn off the Capslock key and type the letters.

Caps Lock

Pressthe Enter Key to start anew line.

Typing Numbers
Stepsto type numbersusing the keyboard.
I Type numbers using the keyboard.
I Pressthe Enter key to start anew line.
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6.

* NUMERIC EEYBOARD

Undo, Redo and Erasing Text

@ 4 O -

Quick Access
Toolbar ,

Undo Button

Paste j B 7 g

Clipboard ™

I

w
N
[

Backspace

(- —

Insert

=4 Calibri (Headings) - 112

Number Keys

Redo Button

Page Layout References N

A.. &

ol
2 ah
-éex,an-}.)-A-

Fant I

Delete
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7. Saving a document

steps t0 save a document
1. Click on the File men,

Always save your
viotk, so that you
can use it in the
future.

.....

2. Select the Save As option.
3. Click the Browse options.

4. The Save As dialog box
opens.

5. Select the Documents
location.

6. Give a proper name for
your document.

7. Click the Save button.

L
[ R S
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g. Closing a document

..... ORI PNy e e

Steps to close the document
1.

9 Opening a Saved Document

Steps to open a saved document

(cik the e uton)

Click on the Close button to close the MS Word window,

T TTrmrese wwaaLE LCYUITTE

1. Select the File menu
and click on Open,
2. Click Browse.

The open dialog box
appears as shown below:

...L.A‘,.

»

L
B = Vst ¢ v + L) —
p——" —— Lo 2 0
Comtrn Dhast 70 b —— [
[t e e -
® D it st 1L ALt . LT g
W hn P ramear v -
D o weaneasn W oo
s p—ra—— P 2™ i
\ _.=—— ans T L - —
P Bowewn | @ wae ORERION Aams
e 2 e

— AN T 2 g

3. Select the
location where
the file is saved.

4. Type the name of

the file.

5 Click on Open to
open the file.
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Delhi Public School, Gandhinagar

Class- 111
Computer Sample Notebook (Month August’24)
L .2 Hardware and Software

Page No. 17

L « Jump Start | ————————

Tick the correct option if the devices are input or output.

: . ; o .. {
£ s - )
: § : \
: 3 i {
. . 8 l)

Monitor : Mouse i Printer
Input Output input OQutput Input Outpu

—

[ & g )

Keyboard Headphones Microphone Speakers )
Input (}ul;)ut] Input Out input Output Input Output
& 0 O & 0 O &
e e e i i i S i i Nt N N SNt
17
Page No. 25
e

ASSESSMENT
ﬁ TIME
Section-l

A  Fillin the blanks.

I. All the physical parts of a computer that you can see, touch and
feel are called hardware.

2. The scanner converts printed data or images from paper to
digital data format.

3. Apen driveis mostly used to transfer data from one computer
lo another.

4. Microsoft Windows :
i A _ 18 an operaling system.

Page 1 of 5




z Write (T) for true or (F) for false statements.
L. A computer uses an output device to show the result. (

. A webcam is an input device.

2
3. A hard disk stores data permanently.
4

. Application software are used to control the functionality
of a computer.

¢ Multiple Choice Questions

| Which of the following is not an input device?
(a) CPU ~  (® Mouse O
(¢) Scanner O (d) Keyboard O

2. Which of the following controls the overall activities of a computer,
(a) Notepad O (b) Operating System
(c) Paint O (d) MS Word

1 Which of the following is an operating system?

(a) Notepad O (b) Tux Paint

(¢c) Windows g (d) Paint
n a computer is an example of

O
O
O
1
4. The game you piay © 5 L Bame ?
O

:a; Ta::tw::f/icc # (d) Operating System
¢) In

D. Answer thefollowing.

1.  What isthe use of a processing device?
Ans. A devicethat is used to process theinput datais called Processing device.
CPU is used to process the data and produce the result.

Page 2 of 5




2.  What is asoftware?

Ans. Softwareisaset of instructions that tells the computer what to do. It isalso caled
acomputer program.

3.  What isan application software? Mention any two examples.
Ans. Application software is aset of one or more programs used to accomplish
a specific task. For example:- MS Paint, Tux Paint.

4.  What is a system software? Mention any two examples.
Ans. System software controls the overall functioning of computer.
For example:- Microsoft window, Apple Mac OS

Page No. 27

E Write down whether the following are hardware or software.

Components Hardware/Software

|. Operating System Saftware —

2. Paint ‘Software

3. Notepad _ Software

4. Microphone _Hardware

5. Mouse _Hardware
Page No. 27

F  Unscramble the following input and output devices,

@) RMNIOTO (M[o|N [IJ_,OR
b HPHDENAOE ‘H|E1A|Di;7 H\olme
) CSNANRE b[ClAI_NJ:[‘J_QiR
@ EKSAPESR _)EDEF—
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Application Based Questions

1. Sal iswriting an essay using the word processor on a computer in the school. She
wants to take the essay home to work on it. But the computer does not have a
CD/DVD drive. Suggest to her the device that she can use for this purpose.

Ans. Pendrive

2. Write the name of the input or output device that you will use in the situations given

below.

Ans. (@) Torecord asong in your own voice Microphone
(b) To type aletter Keyboard
(c) To select afile on the screen Mouse
(d) To get ahard copy of your typed letter Printer
(e) To play music at abirthday party Speakers

CBE Based Questions

1. Which of the following are types of Software?
(@) System (b) Application (c) Both (a) and (b) (d) None

2. Which of the following is not an Operating System?
() Windows (b) Linux (c) i0S (d) MSWord

3. Which of the following is Application Software?
(@) Tux Paint (b) WordPad (c) Paint (d) All of theabove

4. Which of the following is aset of Instructions?
(a) Program (b) Software  (c) Both (a) and (b) (d) None

5. A hard disk isthe secondary storage device of acomputer. (Trueor False)  True

6. A CDisfixedinthe CPU. (Trueor False) False

7. A DVD isused to store videos and movies. (True or False) True
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8. A pendriveis connected to the computer through a USB port.
(True or False) True

9. Theoutput that is printed on a paper is called a hard copy.

10. Headphones usually have an attached Microphone.

11. Storage Devices are used to store data on the computer.

12. A CD/DVD isacircular-shaped storage device.

13. ldentify and Mark the below given pictures as Hardware (H) and Software (S).

14. ldentify and circle the storage devices.
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Delhi Public School, Gandhinagar
Class- |1
Computer Sample Notebook
L.6 Morein Paint (Aug’24-Sept’24)

@:Jumpsmnl- e o S

' Create the following drawing in Paint using various shapes
\
\

To bedonepractically.

| f— oo wing drawing
757 4 A‘:L—!.-"w 1 :;ral\‘:lvsth:afi:lt'ousing vario?g |
: » shapes and colour it. ,
| e
To bedonepractically.

———— e

— Draw any two fruits of your choice and
colour them. Also, name the fruits with the
help of the ‘Text’ tool.

e ——
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* ASSESSMENT
TIME

) Section-
A Fill in the blanks,

1 Microsoft Paintis a simple graphics program in which you can draw and

colour various pictures.
2, The Select

tool is used to select any part of the image.

3. The Free-Form selection tool is used to select part of the image in
an irregular shape.

4. _Rotate means to turn the selected picture horizontally or vertically.
3. The Color Picker tool is used to select or pick a colour from the drawing

)

Page No. 85

B Multiple Choice Questions, :
. - 7 4 '

1. You can select parts of a picture by making use of the “
tools. m——— )

! 5 |

(a) Copy (O ® Rectangular seiection () )

(¢) Freeform selection O (d) Both b and ¢ g ‘.

2. The Resize option is present in the '

(a) Ribbon (b) Toolbar O |
(¢) Drawing area 0 (d) None of these O

3. To zoom in on a section of an inpage, you should use ool
(a) Magnifier (jﬁ (b) Free-Form
(c) Brush 0 (d) Eraser O '

4. Which command is used to copy the image? O
(a) Copy (b) Cut O
(¢) Zoom-in O (d) Rotate

Page No. 85
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X s

C ' Write the purpose of the following tools:

-To remove the result
1. Undo | of previous action.

3. Zoom-in

-To view the drawing
in bigger size.

2. Rotate | -To flip the image horizontally

or vertically.

4. Color picker

-To pick a color
from the drawing.| |

Page No. 85

D. Answer thefollowing.

1. How many selection tools are present in MS Paint? Name them.
Ans. Therearetwo types of selection toolsin M S Paint. The Rectangular selection

and Free-Form selection tool.

2. What do you mean by zooming an image?
Ans. Zoomingisused to view imagein a bigger sizeThisiscalled zoom in or magnify.

3. Which command is used to view the image in abigger size?

Ans. Themagnifier tool isused to view theimagein larger size.

Page No. 85

Section-ll

;;‘;} Art Integration

(reate a Teacher’s day card for your teacher in Paint.

To bedonepractically.
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10.

11.

12.

CBE Based Questions

Which of the following contains the Paint option?
(a) Windows Accessories (b) Start  (c) All Programs (d) Control Panel

Which of the following contains the Select command?
(&) Image (b) Tools (c) Shapes (d) None of the above

Which of the following contains the tools to Flip the image?
(a) Rotate (b) Select (c) Tools (d) None of the above

Which of the following options is used to move the image?
(a) Cut, Paste (b) Copy, Paste  (c) Move (d) None

The Rectangular Selection tool is used to select an image or part of the image
in arectangular form. (Trueor False)

—
—
c
D

o)
8

The Color 1 isselected for the Eraser tool to erase things. (True or False) F

o)
8

Y ou cannot change the size of aPicture onceit is saved. (True or False) F

Y ou can make drawings with abrush or Pencil tool. (True or False) True

The Color picker tool is used to select a color from the drawing.

The M agnifier command allows you to view the drawing in asmaller size.

The resize option is present in the | mage group.

The Magnifier tool is present in the T ools group.
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Delhi Public School, Gandhinagar

Class- 111

AlL: Practical
L.6 Morein Paint

Note: Follow the detailed steps given in the textbook L -6.

Opening Paint
i. Click on start.
ii. Click on Windows Accessories.

ili. Click on Paint.

__J My Docurments

é Inket et
Drvherryat &= plore

" Eemait

Caxltok Expres

® Wz Meda Py
m Wt Movie Makd

|1 P 3\ My Recent Docurments »
Windows Catelog

Windoa s Lpdate
M Rich Teod Cocumunt

0 Accessixity
) Commuricetonrs
0 Ervestoivieny
£ =retem Taok
Adkhess Book
Cabodator
Commad Fromos

LalwTen

Statup

Irtecree Explocer

Catbook Exprase

w Flos and Settngs Tr
W eeard

ﬁ FroecCel
§ B windoaws Messengar

Al Programs B ) e

b RoTcte Ascistancs
&) Windouws Mecta Flaysr

Wivdows Explceer

P e deiiin P09 te PAN e

(Or)
I. TypePaint in the Search box.
ii.  Click on the paint application.

-0 .
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Selecting Drawings
i.  Using the Rectangular Selection T ool
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Using the Free-Form Selection Tool

1 " = | Unotled - Pait
bginagls Irm

#
.__]i Casi A l."'
r-_u ] =\ Rt . H B r T
B s o e
Erctarigul 4
uetormanl n
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3. Cut and Paste a Picture

4. Copy and Pastea Picture
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= 11 <

3 <>

5. Using aColor Picker Tool

7oA
7|2Q
Tople
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Using Undo Command

|| ® & = | Untitled - Paint |

Home View

3.

x

Using Magnifier Tool
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1 - F

8. Flippingthelmage

i T
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9. Resizingthelmage

I- =3 b
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oy (o]
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Ja.
- A
| e
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ol | Cokai
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@ Delhi Public School, Gandhinagar

Half Yearly Examination (2024-25)

Classll| ]( Computer Science T Date: .09.24
\ Time: L Sample Paper J\ M. Marks: )
Name: Sec: Roll No:

Q-

General Instructions:

(i) There are 3 sections in this paper.

(i) All the questions are compulsory.

(iii) Answer the questions as per given instructions.

Section - A
Tick the correct option from the following.(Multiple Choice
Questions)

Identify the input from the PO cycle given below.

P
\'g/ \l
¥ 2 [
4 ‘ N A\
o 4 '/ . v

VA
(@ (b) (©)
The result of processing is called
(a) Output (b) CPU (c) process

isanicon that islinked to afile or afolder.

(a) Shortcut (b) Folder (c) Icons

The operating system provides a graphical
user interface.

(&) DOS (b) MSWord (c) Windows

tool isused to select any part of theimage.

(a) zoom (b) Select tool (c) Icons

Windows is the product of

(@) Infosys (b) Intel (c) Microsoft
A folder containing subfolder is called the

(a) subfolder (b) File (c) parent folder
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Q-1
1.
2.
3.
4.
5.
Q-1
Ans.
Q-1v
1.
2.
3.

Identify the ‘File Explorer’ icon from the pictures given below.

@

(b) (©)

Section-B

State whether the following statementsare True (T) or False (F).

Computers cannot work for many hours.

An operating system loads first when the computer starts.

A folder can contain multiplefiles.

A computer uses output device to show result.

The select tool is used to select any part of theimage in MS Paint.

Match the following.

Column A Column B
A type of computer whichis .
1. | also used to make calls. A. | WhatsApp, MS Paint
2. | Application Software B. | Central Processing Unit
3. | Helpsto organizefiles. C. | Color picker
4. | Processing Device D. | Smart phone
5 To pI.Ck acolor from the E | Folder
drawing
1. 2. 3. 4. 5.

Write ‘I’ for Input and ‘O’ for output for the following devices.
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Ans.

Ans.

Q-VI

@

Answer thefollowing questions.

Section-C

Name any two input devices.

What are Icons?

Which option is used to search for files in a computer?

Application Based Questions.

Rearrange the jumbled wordswith the help of given picturesin M S Paint.

D

O
P I N T A

: {M R|U| S| H|B| S|E
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Delhi Public School, Gandhinagar
Class- 111
Computer Sample Notebook
L.7 File Management

Page No. 88

Look at the Fij) i ==y = ]!
5 lle Explorer window == 22 =

>OWN and answer the questions == =F={
given below. = jj
1. Mention the names of any 2 folders = f
shown in the window. = “File Explo |

rer )

Class 7, Class 8
2. Mention the name of any one file.
Computers.docx

e e e e ™

Pg.No. 95 Activity — 1 To be done practically
Pg.No. 96 Activity — 6 To be done practically

Page No. 98

e

ASSESSMENT

TIME

Section-l

A Fill in the blanks,

1File Explarer .. o
: 18 a file management application used by Windows OS.
2. The folder containing subfolders is called the Parent folder.

3. Shortcut is an icon that is linked to a file or a folder.
4. A folder inside another folder is called a Sub Folder

Page 1 of 12



Page No. 99

g Write (T) for true or (F) for false statements.

| A folder can contain files and folders. ¥
7 A shortcut is used to organize files. F
3. A File Explorer s used to delete files and folders F
4 A File Explorer is a file management too! T

Page No. 99
TC M ultiple. Choice Questions.
I i‘il? 'S @ collection of data or information
(¢) Shortcut ) Folder

. d
2. A folder can contain multlple( ) None of these

les
a) Onl T === ‘
(&) s ( Multiple

(c) Data (d) None of these
3. What do you called a folder inside a folder?
(4/ Sub folder (b) Child folder
(c) Parent folder (d) Main folder
4. A helps to organize files.
(J Folder (b) Shortcut

(c) File (d) None of these
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Page No. 99

D. Answer thefollowing.

1.  Why do we use folders?

Ans. Foldershelp in storing and organizing filesand data in the computer.

2. What is shortcut?

Ans.

3. Which option is used to search for filesin computer?

Ans. Search box isused to search for filesin a computer.

4. What isthe significance of File Explorer?

Ans. 1. Fileexplorer isafile management application.

2. Itisuseto browsefoldersand files stored on the computer.

Page No. 100

A shortcut isan icon that islinked to afile, folder or a program.

E

Find the words given in the Hints box and circle them.

Xxlc o mM[Plu' T ER
L P N SIrR|lz[s]l c|r|
y U x wlo|u [u] Al[f
A ¢ B Nlaglviolclo
M D F E|[R|x|rR| FL
L L e]|la]wlr]| B[[p
H oK LMolI|lDblE
U/N s T Q|T|u|E Ir]
AR|Y|Uu|Cc|s|[tR1]|P]
slyIN/lAIN|P|B|KI|S

7’ -

E

G -

E

0

T

,U

Computer
File
Folder
Shortcut

Program
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Application Based Questions

1. Saritawantsto navigate and access the files stored on her computer. Which
application should she usefor it.

Ans. File Explorer

2. Sheenahas created afilein Paint. But she forgot the folder where she has saved the
file. Can you help her in finding her file?

Ans. Shehastotypethefilenameor afew lettersof the file namein the search box.

Page 4 of 12



CBE Based Questions

Shyam has created afile in MS-Word. What will be the extension of that word file?
(a) .docx (b) .word (c) .txt (d) None of these

Riyahas drawn apicture in MS Paint but she has forgotten as to where it has been
Saved? Which option from the following will be help her to search her file?

(a) Search Box (b) Search Bar (c) Taskbar (d) None of these

Which of the following is an example of shortcut icon?

(a) File (b) Folder (c) Shortcut (d) Start Button

When you delete afile or folder it goesto the

S Pk P 1
4 M ik Liwss |5

lf.cii[ia._qi;'
(a) RecycleBin (b) ThisPC (c) Start Button (d) Drive

File Explorer is used to view all the drives available on your computer.

(True or False) True

This PC icon on the desktop is used to open the File Explorer.

(True or False) True
Jpg isthe extension of image files. (True or False) True
Y ou cannot rename the folder once created. (True or False) False

File Explorer helpsto browse Folders and Files stored on the Computer.
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10.

11.

12.

A Folder isanamed location on the computer where you can save your
Files.

A Shortcut isanicon that islinked to a File, Folder, or Program.

The folder containing subfoldersis called the par ent folder.

AlL: Practical
File Explorer
v Devices and drives (2) S
i Local Disk (C) New Volume (E) ‘1
— VRSN b ;
| My 129 G8 free of 213 GB W 593 GB free of 716 GB J
I Drives in a Computer

Opening File Explorer

jou can open the File Explorer by clicking on the This PC icon on
the desktop or the File Explorer icon on the taskbar

‘jo-ni_'e"kﬁﬁﬁ‘_{::

@ ° Type here 1o search

3. FileExplorer Windows

Right Pane

Left Pane .

File Explorer Window
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4. Fileand Folders

a‘b
» || A8 '
t

Audio file PG Text file Video file

—

5. Creating a Folder

I. Creatingafolder on the Desktop.
1. Right-Click on the blank area of the desktop. A dropdown menu

anneAarg

2. Select the New option and then click the Folder option
3. A folder is created on the desktop with the default name New Folder.

AMD Radeon Software

View
Sort by
Refresh

Paste
Paste shortcut
Undo Move Ctrl+Z

= [

|# Shortcut

1 Display settings

g Personalize @1 Microsoft Access Database
E Bitmap image
{% Microsoft Word Document
@ Microsoft PowerPoint Presentation
@ Microsoft Publisher Document
#8 WinRAR archive
E| Text Document
ﬂ__‘j Microsoft Excel Worksheet
B8 WinRAR ZIP archive
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3t CLASS TEACHER

Class 1- 5 Name hst session 24-25

CLASS 3 24-25 FULL SYLLABUS FINAL 4

Class 3 Term 1 24-25

L-1 THE COMPUTER SYSTEM

L-5 USING WINDOWS OS 03-05-2024 1616 File folde

Syllabus 2425

Worksheet from Ratnasegar website 3-05-2024 152
23 boot on screen Microsoft Edge P 521 KE
623 CLASS 3 CH 1 SCREEN SHOTS §-03-2024 2207 Microsoft Edge P KE
G2 CLASS 3 CH EXCERCISE PHOTOS FROM ADOBE 6 03-2022 2207 Microsoft Edge P 2,155 KE
623 CLASS 3 L+5 USING WINDOWS OS TXT BOOK EX 403-2024 20:40 E 2 36
Class 4 L4 Editting and Formatting in MS WOrd2016 - Copy 3

computer -classes name list 29032024 2G5 Micresoft Werd D

Qoo

Paper format for PT 1 (S 024 07 Microsoft Word D

li. Creatingafolder inadriveor another folder.
1. Open aFile explorer.
2. Double click on the folder where you wish to create afolder.

3. Rignht click on the folder and select New and the Folder option to
create anew folder.

AMD Radeon Software |

e >
Sort by b ortcut

Group by b 05 Microsoft Access Database

Refresh Bitrnap image

Custormize this folder... M= Microsoft Word Document

Paste [ Microsoft PowerPoint Presentation

@ Microsoft Publisher Document
m WinRAR archive

Paste shortcut

Undo Move Ctrl+Z

|=| Text Document
Give access to > BE Microsoft Excel Worksheet
Properties ‘
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6.

Name

3t CLASS TEACHER

Class 1- 5 Name hist sesseon 24-25
CLASS 3 24-25 FULL SYLLABUS FINAL
Class 3 Term 1.28-25

L-1 THE COMPUTER SYSTEM

3 L-5 USING WINDOWS OS

YI2DUS 242
Worksheet from Ratnasegar website

E3 boot on screen

633 CLASS 3 CH 1 SCREEN SHOTS

G2 CLASS 3 CH EXCERCISE PHOTOS FROM ADOBE

23 CLASS 3 L+5 USING WINDOWS OS TXT BCOK EX

Q@7 Class 4 L4 Editting and Formatting in MS WOrd2016 - Copy

@) computer -classes name fist

G Paper format for PT 1

Renaming a Folder or file

1. Right click on the folder that you want to rename.
2. Select the Rename option. The folder will get highlighted.
3. Typethe required name for the folder.

- PR = Clam 3 T 1.34-25
| Pictures ’ L-1 THE CORPUTER SYSTER
CRSG S 24 L-Er kG WD O
P GER 10 # L-TALE .
i Fimae i
¥ CLASE TELCHER - TSy Rp——
L [ LT
L= 5 LSRG B RCETE 3 P b Chack secmn
Worimhe
TEILE PG RLAGER TRRa
L-THLE il bt ari L]
Syllelis 24-7% =i ] Sean with Micrasch Daferdn_.
P [ - [ wn accmuin
[~ R Antar piwvizn varmzm
S Thin P 3 Qam 5L trecdatn in bbrary
B 5 Cpecnn T T (R P
B Cumbicy A7 Paper e B pddiz archive
Dcumania - Add in Tlow {older. nir®
‘- Czwenizach - Carmpmm and smsl
J" Baluric n Cormprema b “hiew feide i erd smal
= Plhires Candio
W Viders it
= Locnl DBEOCH Capy
e MEw Vedumie TN ] . e
w Miwe Volune ] F
iF Metwark Asnams
Titarm 1 e anbechad Propestes
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7. Deéleting a Folder or File
1. Right click on the folder that you want to delete.
2. Select the Delete option. The folder will get deleted.

Piews Tl b
Bl Adche Scan (60| Qpemn
S O I-TAES S mme o

G CLASSIL-TRIER P Chickaccom
B CLASS 1 PRACTIC] &
63 L7 FLE haanidcen [ Scen wikth Micmaoft Defardar...
e BOOEE T
Plasta gkl s
Incdude i kbrary
P bo Seark
“ S fo archrae
B ddio Tewialdarrs®
“ Compmm and amai._.
ﬂ Compram bz Tdew folder. ™ snd sl

el i

Lt

Capy

e s e e
il nim

WA

Propenes

L

8. SavingaFilein thefolder

1. Select the File Menu in thefile.

B H S O-
HOME  INSERT

s E B A

Select  View Properties  Dn
- Gridlines Ta

Table

2. Choose the Save As option
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3. Choose the desired folder. Type an appropriate name for the file.

[ JEEE

T o OPEG e, = L-TFLEMARAGERERNT »

Dhganue = Fwes fzizim

B 10 Cbgecty " §nTs

B Daktop Plewa fal ey

5| Documents A CLASEIL-7 FILE MANSFEMENT SARPL
4 Doweivads B CLASS 2 ORACTICALS FOR _L-TFILE M&_.
Ji Whsic

o Promunes

B video:

L Looal Dk (T3}

= M glirree (G o

[T L e LA S RRACICALS FOR. L-T FILE MARACERENT BINE &N (#-05-1

Sive m type: | Werd Documant

Fuithore  LENOWD

5w Thosmbne

= Hide Foldar

9. Searchingfor aFile
1. Click on the Search Box.

]

o Your Al pawered Coplct

34 305w 1 VIR 2eCN oty

et iy
L] Sl 0k

n?_' Weet 2071
= Tunding sk

¢ ". Varn P e I b e g

wrh be ) hee 3038 Nl g % o
B ceonons

S TS MOy e Wt Your
-'i Ntspas LR KON VIS noreta g

e 2004 s kay van e e Do

A A fomal on Sn gave

5 Tyeenew 1o seach

2. Type the name of thefile you are searching for.
3. You will get the fileswith ssimilar name. Choose the desired file.
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10. Creating a Shortcut on the Desktop
1. Right click on thefile or folder for which you want to create a shortcui.

2. Choose Send To option and then Desktop (create shortcut).

Ok el W

U = i o il 8 5
CLAGS T M-I TULL AR Tbikd
Do 3 e 128
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Delhi Public School, Gandhinagar
Class- 111
Computer Sample Notebook
(Month: June’ 2024-25)
L.5 Using Windows OS

Page No. 64

~ NN -
o \_"v\-‘\/\ i N
'\,"\"\ S e
~

& Jump Start
.

Evjnbelow < s of applicaton andl SYSTEMm software. Put then
' the correct bucket o |

andows MS- Word, Linux Android, Unix, Paint, Tux Paint Scratchjp
- System Software Application Software

: Mlcrosoft Wmdows MS Word

| Android Paint

Linux Tux Paint

j Unix ScratchJR

. LAAAANANINS A WA NSNS N N NN PN TN —‘-v\,\/\/\/\/w/

ooy '
...............
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“ ASSESSMENT,
' TIME

Section-1

A Fillin the blanks.
-

1. The Operating System is the most important software that runs
on a computer,

The Windows

!~J

operating system provides a Graphical User

'o
\
Interface. \
3. The Desktop is the main screen of the Windows operating \
system.
4. Taskbar

is the long horizontal bar present at the bottom
of the Windows desktop.

E Multiple choice questions.
1. Windows is the product of

(a) Infosys {:} (b) Intel
(c) Microsoft g (d) CPU

2. GUI stands for

(a) Graphic Unique Interface

(c) Graphical User Interface
(d) Graphic Used ID

O
O
O
(b) Graphical Universal Interface %
O
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| W

3. Which of the following holds the clock and other options on the |

desktop?

(a) Icon {:} (b) Taskbar g

(c) Wallpaper {:} (d) Screen-saver 0
. Which of the following is used to see the programs or files in a

computer?

(a) Personalize {:} (b) Desktop 0‘

(c) Wallpaper {:} (d) Start menu g

e _V

¢ Write (T) for true or (F) for false statements.
- NYTTTRITIII T

—

{. An operating system is a system software 8
9. An operating system Joads first, when computer Starts.

3. The desktop is the main screen of the computer. @

®

4 Linux is an application program. @

1.
Ans.  An operating system isthe first software that is loaded into the computer when we

5 An icon represents a file, folder or program.

What isan operating system?

start the computer. It controls and manage all operations of the computer.
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2. Differentiate between Command-Line Interface and Graphical User Interface.

Ans. Command line Interface Graphical User Interface
(i) The CUI allowsthe user to interact with (i) GUI provides agraphical interface
the computer system by typing commands using, icons, menus and images.

using the keyboard
(i1) Eg: DOS (Disk Operating System) and  (ii) Eg: Microsoft Windows, Linux,
UNIX. Mac OS.

3. What arelcons?
Ans. |cons are the small pictures that represent as application, afile or afolder on the
desktop. For example : This PC, Recycle Bin and Network etc.

4. List any two activitiesthat you can do using the start menu.
Ans.  (a)View alist of al programs installed on computer.
(b) Open the ‘File Explorer’ to navigate files and folders.

Page No. 73

Application Based Questions
1. Samayrawantsto see all the open applications. Suggest her which option to use to
view the opened application.
Ans. Shecan use Task View Button to shows/view all open applications.

2.  Shavy wants to write all the installed applications on her computer. But sheisunable
to see dl the installed applications on the computer. Help her in completing her task.

Ans. Shecan Click on Start button to view all the programs installed on the computer.
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~
A Lab Time
I. Perform the tasks given below.

Note down the answers in your notebook,

Task 1: Observe the taskbar of your desktop. Note the name of
opened programs if any.

Task 2: Click on the Start button on the taskbar,

Task 3: Open any two applications.

b |
Iask 4: OQbserve the taskbar again Note the name of on
programs, o
Task &: Click the Task View icon and check if all open win
are visible on the desktop o
To be done in the computer lab practically.
CBE Based Questions
Which of the following is not an Operating System?
(@) Ubuntu (b) Linux (c) Microsoft (d) Windows
Which of the following is an example of a CLI operating system?
(@) DOS (b) Unix (c) Windows (d) Both (a) and (b)

Which of the following are versions of Windows?
(& Windows7 (b) Windows11  (c) Windows10  (d) All of the above

Which of the following are common icons on the Desktop?
(a) Network (b) RecycleBin  (c) ThisPC (d) All of theabove

A computer cannot perform any task without an Operating System. (True or False)
True
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10.
11.

12.

13.

The CLI-based operating systems are easier to use when compared to GUIs

(True or False) False
A taskbar is along horizontal bar seen at the bottom of the Windows desktop.
(True or False)

The Network icon checks if you are connected to a network. (True or False) True

—

ru

D

Operating System controls and manages all operations of the Computer.

The OS allows to interact with the computer by providing a Graphical Platfor m.

A Command-Line User Interface (CLI) isatext-based interface.

The Start button is used to display the Start menu.

Label the circles given below with numbers 1, 2, 3, 4 and 5 by carefully
matching definition for the marked parts of Windows Desktop.

1 - Small pictures that represent an application, afile or a
folder.(I cons)

2 - Thelong horizontal bar seen at the bottom of the windows
desktop.(Taskbar)
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3 - Thisbutton is used to display the start menu. (Start Button)

4 - Digital image or photo used as background on the screen of the computer.
(Desktop Background / Wallpaper)
5 - Shows the current time and date.(clock)
AlL: Practical

1. Introducing the students to Command Line Interface (CLI)

e StepstoinvokeaCLI:
I. Windows key + R to start acmd prompt

ii.  Type ‘emd’ in the screen shown below

Run > I

Type the name of a program, folder, document, or Internet
— rescurce, and Windows will open it for you,

Open: ~

Cancel Browse...

ili.  Press OK to see the Command Line Window as shown below

B A e S ST T ¢ el - O S

2. Introducing students to Graphical User Interface (GUI)- Window 10

I. Introduction to Boot Screen of windows.
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iii.  Introduction to the components of windows
e Desktop

Notification Area

Icons

Taskbar

Desktap backgraound

Start button | (Taskbar | Windows 10 desktop

e Start Button

iv. ldentifying the common icons on the Desktop screen like
« RecycleBin

o Network
o« ThisPC
v. ldentifying the components of a Taskbar:
I Start Button
ii.  Taskview
iii.  Program tab
iv.  clock
O Hyerorw wn o m @ wma @ ® Y SWChm ~BOTW Y

I Start I;utton] f@ée_vﬂ ( Program tab]
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Delhi Public School, Gandhinagar

Class 11
Computer Sample Notebook
L.1 The Computer System

(S Jump Start| e
@

! Identify, which are the parts of the computer and circle them.
Rat PUC Board

Keyboard Blackboard  Phone

Cat Cupboard Cooker Pen

&, ASSESSMENT,
&
Section-l
A Fillin the blanks.

el e ™, e, A, s A,

1. A computer needs instructions  to work.

Input-Process-Output (IPO
2. The computer system works on the - pcyi': e.]

3 The CPU works on the input given by the user.

4. The result of the processing is called __outpul
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| 2 _ Multiple Choice Questions.
l. What is the use of a smartwatch?
(a) It is used to browse the internct
(b) Tt is used to make and receive calls

(c) It is used to listen music

(d) All of these /\7
; 2. The result of the processing is called the

(a) CPU (3} (b) Input )

(c) Output g (d) Process O

3. are small computers that you can carry with you 10
other places easily.

(a) Laptop (:,, (b) Desktop O’

(c) Tablet Q (d) Botha & ¢ @’

4, A is a computer device that can be held in your hands.

(a) CPU O (b) Desktop (3
(c) Tablet @/ (d) Laptop 5:;
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C Write (T) for true or (F) for false statements.

© 1. Smartwatch can also be used to browse the internet,
2. Computers cannot work for many hours.
3. A computer can store a large amount of data.
4, A computer never makes mistakes.
5

. The result of a processing is called output.

Ans.

Ans.

Ans.

Ans.

Answer the following questions:
Name any two input devices.
Keyboard, Mouse, Scanner are the various input devices.

Name any three types of computers.

Desktop Computer, Laptop Computer, Tablet, Smartphone, Smartwatch are the three
types of computers.

What isthe full form of 1PO?
| PO-Input-Process-Output is the full form of 1PO.

Write any two advantages of computers.

a. High Speed: A computer is avery fast machine.
b. Multitasking: A computer can do many tasks at the same time.
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section-ll

XL application Based Questions [ Experimentol Leaminy

1. Mansi is going on a trip with her famnly.-She wants 10 keep ip
touch witlg\ her friends and teachers. Which device she.should
carry to keep in touch with her friends and do study online?

Ans. She hasto take her laptop and smartphone with her to keep in touch with her friends and
teacher and to study online.

2. Write the Input, Process, and Output cycle for any real-life
application used in the everyday task at home.

Ans. Input — Dialing the number.

Process- Connecting the number.
Output — Talking to your friend.

.-- H o 4
i@ Project Work

Create a chart on the “Various Types of Computers” using pictures. And
paste it on the wall of your classroom.

To be done once informed in the class by the teacher.
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1. Which of the following are the advantages of computers?
(@) Versatile  (b) Multitasking (c) High Speed (d) All of the above

2. Which of the following is not an input device?
(a) Scanner (b) Printer (c) Monitor (d) Both (b) and (c)

3. Which of the following is required by a computer to perform atask?
(@) Output (b) Input (c) None (d) Both (a) and (b)

4.  Desktop computers are designed to carry anywhere. (True or False) False
5. You can work with aLaptop without electricity. (Trueor False) True

6. A Tabletishigger than aLaptopinsize. (Trueor False) False

7. Theresult of the processing is called the Output. (True or False) True

8. A computer is made up of many different parts.

9. A computer accepts data, processes it and then gives the result.

10. Input can be given with the help of input devices.

11. The CPU works on the input given by the user.
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